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using this
manual

This user manual has been specially

designed to guide you through the functions and
features of your mobie phone. To get started quickly,
refer to “introducing your mobile phone,”
“assembling and preparing your mobile phone,”

and “using basic functions.”

Instructional icons

Before you start, familiarise yourself with the icons
you will see in this manual:

Warning—situations that could cause
wame  Injury to yourself or others

& Caution —situations that could cause

et damage to your phone or other equipment

Note—notes, usage tips, or additional
information

> Refer to—pages with related information;

for example: » p.12 (represents “see page
127)



Followed by—the order of options or
menus you must select to perform a step;
for example: In Menu mode, select
Messages —> Create message (represents
Messages, followed by Create message)

Square brackets —phone keys; for
example: [e=*] (represents the Power/
Menu exit key)

Copyright information

Rights to all technologies and products that
comprise this device are the property of their
respective owners:

o Bluetooth® is a registered trademark of the
Bluetooth SIG, Inc. worldwide.
Bluetooth QD ID: BO15287.

e Java™ is a trademark of Sun Microsystems, Inc.

o \Windows Media Player® is a registered trademark
of Microsoft Corporation.
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safety and
usage
information

Comply with the following precautions to avoid
dangerous or illegal situations and ensure peak
performance of your mobile phone.

& Safety warnings

WARNING

Keep your phone away from small
children and pets

Keep your phone and all accessories out of the
reach of small children or animals. Small parts may
cause choking or serious injury if swallowed.

Protect your hearing

Listening to a headset at high volumes can
damage your hearing. Use only the
minimum volume setting necessary to hear

your conversation or music.
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Install mobile phones and equipment
with caution

Ensure that any mobile phones or related equipment
installed in your vehicle are securely mounted. Avoid
placing your phone and accessories near or in an air
bag deployment area. Improperly installed wireless
equipment can cause serious injury when air bags
inflate rapidly.

Handle and dispose of batteries and
chargers with care

e Use only Samsung-approved batteries and
chargers specifically designed for your phone.
Incompatible batteries and chargers can cause
serious injuries or damage to your phone.

* Never dispose of batteries or phones in a fire.
Follow all local regulations when disposing used
patteries or phones.

e Never place batteries or phones on or in heating
devices, such as microwave ovens, stoves, or
radiators. Batteries may explode when
overheated.

® Never crush or puncture the battery. Avoid
exposing the battery to high external pressure,
which can lead to an internal short circuit and
overheating.

Avoid interference with pacemakers

Maintain a minimum of 15 cm (6 inches) between
mobile phones and pacemakers to avoid potential
interference, as recommended by manufacturers
and the independent research group, Wireless
Technology Research. If you have any reason to
suspect that your phone is interfering with a
pacemaker or other medical device, turn off the
phone immediately and contact the manufacturer of
the pacemaker or medical device for guidance.



Turn off the phone in potentially
explosive environments

Do not use your phone at refuelling points (service
stations) or near fuels or chemicals. Tum off your
phone whenever directed by waming signs or
instructions. Your phone could cause explosions or
fire in and around fuel or chemical storage and
transfer areas or blasting areas. Do not store or carry
flammable liquids, gases, or explosive materials in
the same compartment as the phone, its parts, or
accessories.

Reduce the risk of repetitive motion
injuries

While using your phone, hold the phone with a
relaxed grip, press the keys lightly, use special
features that reduce the number of keys you have to
press (such as templates and predictive text), and
take frequent breaks.

& Safety precautions

CAUTION

Drive safely at all times

Avoid using your phone while driving and obey all
regulations that restrict the use of mobile phones
while driving. Use hands-free accessories to
increase your safety when possible.

Follow all safety warnings and
regulations

Comply with any regulations that restrict the use of a
mobile phone in a certain area.

Use only Samsung-approved
accessories

Using incompatible accessories may damage your
phone or cause injury.
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Turn off the phone near medical
equipment

Your phone can interfere with medical equipment in
hospitals or health care facilities. Follow all
regulations, posted warnings, and directions from
medical personnel.

Turn off the phone or disable the
wireless functions when in an aircraft

Your phone can cause interference with aircraft
equipment. Follow all airline regulations and tumn off
your phone or switch to a mode that disables the
wireless functions when directed by airline
personnel.

Protect batteries and chargers from
damage

e Avoid exposing batteries to very cold or very hot
temperatures (below 0° C/32° F or above 45° C/
113° F). Extreme temperatures can reduce the
charging capacity and life of your batteries.
Prevent batteries from contacting metal objects,
as this can create a connection between the +
and - terminals of your batteries and lead to
temporary or permanent battery damage.

e Never use a damaged charger or battery.

Handle your phone carefully and

sensibly

* Do not allow your phone to get wet—liquids can
cause serious damage. Do not handle your
phone with wet hands. Water damage to your
phone can void your manufacturer's warranty.



Avoid using or storing your phone in dusty, dirty
areas to prevent damage to moving parts.

Your phone is a complex electronic device—
protect it from impacts and rough handling to
avoid serious damage.

Do not paint your phone, as paint can clog
moving parts and prevent proper operation.

If your phone has a camera flash or light, avoid
using it close to the eyes of children or animals.
Your phone may be damaged by exposure to
magnetic fields. Do not use carrying cases or
accessories with magnetic closures or allow your
phone to come in contact with magnetic fields for
extended periods of time.

Avoid interference with other electronic
devices

Your phone emits radio frequency (RF) signals that
may interfere with unshielded or improperly shielded
electronic equipment, such as pacemakers, hearing
aids, medical devices, and other electronic devices
in homes or vehicles. Consult the manufacturers of
your electronic devices to solve any interference
problems you experience.
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Important usage information

Use your phone in the normal position
Avoid contact with your phone’s internal antenna.

Allow only qualified personnel to service
your phone

Allowing unqualified personnel to service your phone
may result in damage to your phone and will void
your warranty.

Ensure maximum battery and charger

life

e Avoid charging batteries for more than a week, as
overcharging may shorten battery life.

o Over time, unused batteries will discharge and
must be recharged before use.

Disconnect chargers from power sources when
not in use.

Use batteries only for their intended purpose.

Handle SIM cards and memory cards
with care

Do not remove a card while the phone is
transferring or accessing information, as this
could result in loss of data and/or damage to the
card or phone.

Protect cards from strong shocks, static
electricity, and electrical noise from other devices.
Frequent writing and erasing will shorten the life
span of memory cards.

Do not touch gold-coloured contacts or terminals
with your fingers or metal objects. If dirty, wipe the
card with a soft cloth.



Ensure access to emergency services

Emergency calls from your phone may not be
possible in some areas or circumstances. Before
travelling in remote or undeveloped areas, plan an
alternate method of contacting emergency services
personnel.

Specific Absorption Rate (SAR)
certification information

Your phone conforms to European Union (EU)
standards that limit human exposure to radio
frequency (RF) energy emitted by radio and
telecommunications equipment. These standards
prevent the sale of mobile phones that exceed a
maximum exposure level (known as the Specific
Absorption Rate, or SAR) of 2.0 watts per kilogram
of body tissue.

During testing, the maximum SAR recorded for this
model was 0.943 watts per kilogram. In normal use,
the actual SAR is likely to be much lower, as the
phone has been designed to emit only the RF
energy necessary to transmit a signal to the nearest
base station. By automatically emitting lower levels
when possible, your phone reduces your overall
exposure to RF energy.

The Declaration of Conformity at the back of this
manual demonstrates your phone’s compliance with
the European Radio & Terminal Telecommunications
Equipment (R&TTE) directive. For more information
about the SAR and related EU standards, visit the
Samsung mobile phone website.
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Correct disposal of this product
(Waste Electrical & Electronic Equipment)

(Applicable in the European Union and
other European countries with separate
collection systems)

mmmm his marking on the product, accessories

or literature indicates that the product and
its electronic accessories (e.g. charger, headset,
USB cable) should not be disposed of with other
household waste at the end of their working life. To
prevent possible harm to the environment or human
health from uncontrolled waste disposal, please
separate these items from other types of waste and
recycle them responsibly to promote the sustainable
reuse of material resources.

Household users should contact either the retailer
where they purchased this product, or their local
government office, for details of where and how they
can take these items for environmentally safe
recycling.

Business users should contact their supplier and
check the terms and conditions of the purchase
contract. This product and its electronic accessories
should not be mixed with other commercial wastes
for disposal.

This EEE is compliant with RoHS.



Correct disposal of batteries in this
product

(Applicable in the European Union and
other European countries with separate
battery return systems)

This marking on the battery, manual or
packaging indicates that the batteries in this product
should not be disposed of with other household
waste at the end of their working life.

Where marked, the chemical symbols Hg, Cd or Pb
indicate that the battery contains mercury, cadmium
or lead above the reference levels in EC Directive
2006/66. If batteries are not properly disposed of,
these substances can cause harm to human health
or the environment.

To protect natural resources and to promote material
reuse, please separate batteries from other types of
waste and recycle them through your local, free
battery return system.

Disclaimer

Some content and services accessible through this
device belong to third parties and are protected by
copyright, patent, trademark and/or other intellectual
property laws. Such content and services are
provided solely for your personal noncommercial
use. You may not use any content or services in a
manner that has not been authorized by the content
owner or service provider. Without limiting the
foregoing, unless expressly authorized by the
applicable content owner or service provider, you
may not modify, copy, republish, upload, post,
transmit, translate, sell, create derivative works,
exploit, or distribute in any manner or medium any
content or services displayed through this device.

uonewJoyul abesn pue Alajes .
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“THIRD PARTY CONTENT AND SERVICES ARE
PROVIDED "AS IS." SAMSUNG DOES NOT
WARRANT CONTENT OR SERVICES SO
PROVIDED, EITHER EXPRESSLY OR IMPLIEDLY,
FOR ANY PURPOSE. SAMSUNG EXPRESSLY
DISCLAIMS ANY IMPLIED WARRANTIES,
INCLUDING BUT NOT LIMITED TO, WARRANTIES
OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. SAMSUNG DOES NOT
GUARANTEE THE ACCURACY, VALIDITY,
TIMELINESS, LEGALITY, OR COMPLETENESS OF
ANY CONTENT OR SERVICE MADE AVAILABLE
THROUGH THIS DEVICE AND UNDER NO
CIRCUMSTANCES, INCLUDING NEGLIGENCE,
SHALL SAMSUNG BE LIABLE, WHETHER IN
CONTRACT OR TORT, FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL OR
CONSEQUENTIAL DAMAGES, ATTORNEY FEES,
EXPENSES, OR ANY OTHER DAMAGES ARISING
OUT OF, OR IN CONNECTION WITH, ANY
INFORMATION CONTAINED IN, OR AS A RESULT

10

OF THE USE OF ANY CONTENT OR SERVICE BY
YOU OR ANY THIRD PARTY, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES."

Third party services may be terminated or interrupted
at any time, and Samsung makes no representation
or warranty that any content or service will remain
available for any period of time. Content and
services are transmitted by third parties by means of
networks and transmission facilities over which
Samsung has no control. Without limiting the
generality of this disclaimer, Samsung expressly
disclaims any responsibility or liability for any
interruption or suspension of any content or service
made available through this device.

Samsung is neither responsible nor liable for
customer service related to the content and
services. Any question or request for service relating
to the content or services should be made directly to
the respective content and service providers.



Unpack

i n-tro d U Ci n g you r Check your product box for the following items:

e Mobile phone

mobile phone =< ...

) ) ‘ e User manual
In this section, leam about your mobile phone’s

layout, keys, display, and icons. @ The items supplied with your phone

may vary depending on the software
and accessories available in your
region or offered by your service
provider. You can obtain additional
accessories from your local Samsung
dealer.



Phone layout

The front of your phone includes the following keys

- and features:

auoyd ajiqow JnoA Bupnpoaul

)

et by / o ——Front camera
lens

Volume key—s Earpiece

Memory card____} Touch screen
slot
Cancel key /
M._ | Power/Menu
" // exit key
Dial key - <
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Mouthpiece

The rear of your phone includes the following keys
and features:

—Rear camera lens

— Flashbulb
Multifunction—el
jack

—Battery cover

*—Internal antenna

Camera key—p

',, You can lock the touch screen and keys to
d prevent any unwanted phone operations. To
lock, press the Hold key.



Keys

Key

ﬂ] Camera

Function

In Idle mode, tum on the camera
(press and hold); In Camera mode,
take a photo or record a video; If
you change the key function, open
the application switch window to
access other applications without
exiting the current application (press
and hold)

Key Function
M Hod Look or unlock the touch screen
and keys
Meake or answer a call; In ldle mode,
(—( Dl retrieve recently dialled, missed, or
received numbers
In Menu mode, retum to the
Cancel previous menu level
Tum the phone on and off (press
E/l%vr:er/ex'rt and hold); End a call; In Menu
U mode, retum to Idle mode
D Volume  Adjust the phone's volume

13
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Display Icons
Your phone's display consists of the following areas: LLearn about the icons that appear on your display.

TR i (KT — con line lcon  Definition

Displays various icons )
- Yl  Signal strength
g @  GPRSnetwork connected
s
é S s T€Xt and graphic area E] EDGE network connected
Q Displays messages,
§ instrr)ucytions‘ anc%] @ UMTS network connected
o) information you enter —
g HSDPA network connected
o
é’ \Voice call in progress
[}

Video call in progress

SOS message feature activated

I AN

Browsing the web

14



Icon Definition Icon Definition

Connected to secured web page New emall message

&

@

E] Roaming (outside of normal service area) New voice mail message

©  Caldverting activated (] Normal profile activated

B Synchronised with PC 8  Slentprofie activated
Bluetooth hands-free car kit or headset Battery power level
connected

Current time

Bluetooth activated

Alarm activated

auoyd ajigowl JnoA Buionpoul .

Memory card inserted

New text message (SMS)

rdERC: 1

New multimedia message (MMS)

15



assembling and
oreparing your
mobile phone

Get started by assembling and setting up
your mobile phone for its first use.

16

Install the SIM or USIM card and
battery

When you subscribe to a cellular service, you will
receive a Subscriber Identity Module, or SIM card,
with subscription details, such as your personal
identification number (PIN) and optional services.

To use UMTS or HSDPA services, you can purchase
a Universal Subscriber Identity Module (USIM) card.



To install the SIM or USIM card and battery,
1. Remove the battery cover.

'g I{ tk:c(fa phone is on, press and hold [«z»] to tum
it off.

2.

Insert the SIM or USIM card.

e Place the SIM or USIM card in the phone
>

with the gold-coloured contacts facing
down.

¢ Without inserting a SIM or USIM card, you
can use your phone’s non-network services
and some menus.

17
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3. Insert the battery. Charge the battery

Before using the phone for the first time, you must
charge the battery.

1. Open the cover to the multifunction jack on the
side of the phone.

2. Plug the small end of the travel adapter into the
multifunction jack.

4. Replace the battery cover.

With the triangle facing up

Improperly connecting the travel adapter can
& cause serious damage to the phone. Any
CATON. damages by misuse are not covered by the
warranty.

18



3. Plug the large end of the travel adapter into a
power outlet,

4, When the battery is fully charged (the icon is
no longer moving), unplug the travel adapter from
the power outlet.

5. Unplug the travel adapter from the phone.
6. Close the cover to the multifunction jack.

@ About the low battery indicator

When your battery is low, the phone will emit
a warning tone and a low battery message.
The battery icon will also be empty and
plinking. If the battery level becomes too low,
the phone will automatically power off.
Recharge your battery to continue using your
phone.

Insert a memory card (optional)

To store additional multimedia files, you must insert a
memory card. Your phone accepts microSD™ or
microSDHC™ memory cards up to 8 GB
(depending on memory card manufacturer and
type).

Open the cover to the memory card slot on the

1.

side of the phone.

Insert a memory card with the label side facing
up.

19
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3. Push the memory card in the memory card slot
until it locks in place.

To remove the memory card, push it gently until it
disengages from the phone, and then pull the
memory card out of the memory card slot.

20
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using basic
functions

|Leam how to perform basic operations and use the
main features of your mobile phone.

Turn your phone on and off
To turn your phone on,
1. Press and hold [ =™ ].

2. Enteryour PIN and select Confirm (if necessary).
To turn your phone off, repeat step 1 above.

Switch to the offline profile

By switching to the offline profile, you can use your
phone’s non-network services in areas where
wireless devices are prohibited, such as aeroplanes
and hospitals.

To switch to the offline profile, in Menu mode, select
Settings — Phone profiles — Offline.

',, Follow all posted wamnings and directions from
d official personnel when in areas where wireless
devices are prohibited.




Use the touch screen e Drag your finger up or down to scroll through
vertical lists.

Your phone’s touch screen lets you easily select
items or perform functions.

Leamn basic actions to use the touch screen.

',, For the optimal use of the touch screen,
d remove the screen protection film before using
your phone.

e Select an icon to open a menu or launch an
application.

c
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e Drag your finger left or right to scroll through
horizontal lists.

Access menus

To access your phone’'s menus,

1. Inldle mode, select Menu to access Menu
mode.

2. Select a menu or an option.
3. Press the Cancel key to move up one level;

Press [#s» ] to retumn to Idle mode.
Switch applications

LLearn to switch to other applications from a menu,
without closing the menu screen you are using.

' You must change the camera key function to
J Switch (in Menu mode, select Settings —
Phone settings ~> Camera key function).

23
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To switch applications,
1. While using a menu, press and hold the Camera
key.
The following applications are available:
e Call: open the dialling screen
® Music player: launch the music player
* Messages: access the Messages menu
* Browser: launch the web browser
* Main menu: access the main menu screen

2. Select an application.

Use widgets

Learn to use widgets on the widget toolbar.

e Some of your widgets connect to web
services. Selecting a web-based widget may
incur additional charges.

e Available widgets may vary depending on
your region or service provider.

24

Open the toolbar

In Idle mode, select the arrow at the bottom left of
the screen to open the toolbar. You can rearrange
widgets on the toolbar or move them to the idle
screen.

Add the widgets to the idle screen
1. Open the toolbar.

2. Drag a widget from the toolbar to the idle screen.
You can position the widget anywhere on the
screen.

Move the widgets to the idle screen
1. Open the toolbar.

2. Drag a widget from the toolbar to the idle screen.
You can position the widget anywhere on the
screen.



Change the widgets

1.

In Menu mode, select Settings — Display and
light —~ Widget.

Select the widgets you want to include to the
toolbar and select Save.

Access help information

Leamn to access helpful information about your
phone.

1.

SUEFEER N

In Menu mode, select Settings — Display and
light > Widget.

Select Help — Save.

Press [#5»] retun to Idle mode.
Open the widget toolbar.

Select | 2 | from the widget toolbar.

6. Rotate the phone anti-clockwise to landscape
view.

7. Select a help topic to leamn about an application
or feature.

8. Drag your finger to the right or left to get more
information. To return to the previous level, select

Customise your phone

Get more from your phone by customising it to
match your preferences.

Adjust the volume of the key tones

In Idle mode, press the Volume key up or down and
adjust the key tone volume.

25
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Adjust the vibration intensity on the
touch screen

You can adjust the intensity of the vibration when you
touch the phone screen.

1. Inldle mode, press the Volume key up or down.

2. Select Vibration and press the Volume key up or
down to adjust the intensity of the vibration.

Switch to or from the silent profile

In Idle mode, select Keypad and touch and hold #
to switch to or from the silent profile.

Change your ringtone

1. In Menu mode, select Settings — Phone
profiles.

2. Select [» next to the profile you are using.

3. Select Voice call ringtone or Video call
ringtone.

4. Select a ringtone from the list and select Save.
5. Select Save.
To switch to another profile, select it from the list.

Select a wallpaper (Idle mode)

1. In Menu mode, select Settings — Display and
light - Wallpaper.

2. Scroll left or right to an image.
3. Select Set.

Lock your phone
1. In Menu mode, select Settings — Security.
2. Select On under Phone lock.

3. Enter a new 4- to 8-digit password and select
Confirm.



4. Enter the new password again and select
Confirm.

r,, The first time you access a menu that requires
d a password, you will be prompted to create
and confirm a password.

Use basic call functions

Learn to make or answer calls and use basic call
functions.

r,, During a call, your phone automatically locks
J the touch screen to prevent accidental inputs.
To unlock, press the Hold key.

Make a call

1. Inldle mode, select Keypad and enter an area
code and a phone number.

2. Select =]~ Voice call or press [m] to dial the
number.

For a video call, select = — Video call.
3. Toend the call, press [#z*].

Answer a call
1. When a call comes in, press [e].

2. Foravideo call, press [ ] and select Show me
to allow the caller to see you via the front camera
lens.

3. Toend the call, press [*s»].

You can reject incoming calls by using the auto

rejecting; in Menu mode, select Settings —
Application settings — Call — All calls —
Auto reject > On. Then, set up the reject list
and select numbers to reject.

Adjust the volume

To adjust the volume during a call, press the Volume
key up or down.

27
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Use the speakerphone feature

1. During a call, select Speaker — Yes to activate
the speaker.
2. To switch back to the earpiece, select Speaker.
r,, In noisy environment, you may have difficulty
hearing the calls while using the speakerphone
feature. For better audio performance, use the
normal phone mode.

Use the headset

By plugging the supplied headset into the
multifunction jack, you can make and answer calls:

e To redial the last call, press the headset button,
and then press again and hold.

e To answer a call, press the headset button.

e Toend a call, press the headset button.

28

Send and view messages

LLeam to send and view text (SMS), multimedia
(MMS), and email messages.

Send a text or multimedia message

1.

SEREI RN

In Menu mode, select Messages — Create
message > Message.

Select Tap to add recipient — Enter manually.
Enter a destination number and select Done.
Select Tap to add text.

Enter your message text and select Done.
»p.29

For sending as a text message, skip to step 7.
For attaching multimedia, continue with step 6.

Select Add media and add an item.
Select Send to send the message.



Send an email

1.

© ®» N R 0D

In Menu mode, select Messages — Create
message > Email.

Select Tap to add recipient — Enter manually.

Enter an email address and select Done.
Select Tap to add subject.

Enter a subject and select Done.

Select Tap to add text.

Enter your email text and select Done.

Select Add files and attach a file (if necessary).
Select Send to send the message.

Enter text

Enter text and create messages or notes using the
virtual keypad.

1. Select the text input field.

2. Select the appropriate virtual keys to enter text.
e To switch between T9 and ABC modes,
select T9.
e To change case or switch to Number or
Symbol mode, select Abc.
e To switch to Symbol mode, select .

29
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You can use the following text input modes:

Mode Function

Select the appropriate virtual key until the
ABC ’
character you want appears on the display.

1. Select the appropriate virtual keys to enter
an entire word.
2. When the word displays correctly, select
T9
1 10 insert a space. If the correct word
does not display, select _@‘ to select an
alternate word.

Select the appropriate virtual key to enter a

Number
number.

Select the appropriate virtual key to enter a

Symbol symbol.

View text or multimedia messages
1. In Menu mode, select Messages — Inbox.
2. Select a text or multimedia message.

30

View an email

1. In Menu mode, select Messages — Email
inbox.

Select an account.
Select Download.
Select an email or a header.

If you selected a header, select Retrieve to view
the body of the emaill.

SUREIN A

Add and find contacts

LLeam the basics of using the phonebook feature.

Add a new contact

1. Inldle mode, select Keypad and enter a phone
number.

2. Select -/ > Add to Phonebook — New.



3. Select Phone or SIM.
4. Enter contact information.
5. Select Save to add the contact to memory.

Find a contact
1. In Menu mode, select Phonebook.
2. Select the text input field (if necessary).

3. Enter the letter of the name you want to find. You
can also drag , to select the first letter of the
name.

4. Select the contact's name from the search list.
m Once you have found a contact, you can:

* call the contact by selecting (&
e edit the contact information by selecting Edit

Use basic camera functions

LLeamn the basics to capture and view photos and
videos.

',, When you turn on the camera, the display may

d appear blank due to temporary electrostatic
discharge. Try restarting the phone to solve the
problem.

Capture photos

1. Inldle mode, press and hold the Camera key to
turm on the camera.

2. Rotate the phone anti-clockwise to landscape
view.

suonoun oiseq Buisn

3. Aim the lens at the subject and make any
adjustments.
e To turn the flash on or off, select @.
e To set the exposure value, select ().
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4. Press the Camera key to take a photo.
The photo is saved automatically.
After capturing photos, select [»_ to view photos.

View photos

In Menu mode, select My files - Images > My
photos — a photo file.

To categorise and view photos in a wide view,
1. In Menu mode, select Photo browser.

2. Rotate the phone anti-clockwise to landscape

view.

3. Select (@ — a category to categories the
photos.

4, Scroll left or right to view photos.

32

Capture videos

1. Inldle mode, press and hold the Camera key to
turn on the camera.

2. Rotate the phone anti-clockwise to landscape
view.

3. Select (31 > 3 to switch to Recording mode.

4. Aim the lens at the subject and make any
adjustments.
* To change the recording mode, select (m).

e To turn the flash on or off, select @.
e To set the exposure value, select (4.

5. Press the Camera key to start recording.

6. Select B or press the Camera key to stop
recording.
The video is saved automatically.

After capturing videos, select [»] to view videos.



View videos

In Menu mode, select My files — Videos — My
video clips — a video file.

Listen to music

LLearn how to listen to music via the music player or
FM radio.

Listen to the FM radio

1. Plug the supplied headset into the phone’s
multifunction jack.

2. In Menu mode, select Applications ~ FM
radio.

3. Select Yes to start automatic tuning.
The radio scans and saves available stations
automatically.

',, The first ime you access the FM radio, you will
d be prompted to start automatic tuning.

4. Control the FM radio using the following icons:

Icon Function

Set your phone to re-tune frequencies

/u for stations
]/ 6 Change the sound output
Tune a radio station; Select a saved
v radio station (touch and hold)
> Start the FM radio
) Tum off the FM radio

33

=
@,
=

Q
o
D
@,
e}
=
S
=)
2
o
=
@




o
@.
3
«Q
o
]
@,
o
e
c
2
Q
Q
S
12

Listen to music files

Start by transferring files to your phone or memory
card:

* Download from the wireless web. » p. 35

e Download from a PC with the optional Samsung
PC Studio. » p. 46

® Receive via Bluetooth. » p. 51
e Copy to your memory card. » p. 46

e Synchronise with Windows Media Player 11.
»p. 47

After transferring music files to your phone or
memory card,

1. In Menu mode, select Music — Music player.
2. Select a music category — a music file.

34

3. Control playback using the following icons:

Icon Function

-

() Pause playback

> Resume playback

- Skip backward; Scan backward in a file
(select and hold)

o) Skip forward; Scan forward in a file (select

and hold)
NORM  Change the sound effect
_A. Change the repeat mode
8] Activate Shuffie mode




Browse the web

LLearn to access and bookmark your favourite web
pages.
',, ® You may incur additional charges for
d accessing the web and downloading media.
¢ The browser menu may be labelled differently
depending on your service provider.
e Available icons may vary depending on your
region or service provider.

Browse web pages

1. In Menu mode, select Browser - Home to
launch your service provider's homepage.

2. Navigate web pages using the following icons:

Icon Function

(1) 2] Move backward or forward on a web page

Refresh the current web page

Icon Function

2 Zoom on a web page

* Open a list of saved bookmarks

=] Change the view mode

=] Access a list of browser options

Bookmark your favourite web pages

1. In Menu mode, select Browser - Bookmarks.
Select Add.

Select the URL input field.

Enter a web address (URL) and select Done.
Select the title input field.

Enter a page title and select Done.

Select Save.

N O N
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Use the Google Map service

Lean how to use the Google Map service.

r,, Depending on your region, the map service
d may not be available.

To search the map,

1. In Menu mode, select Applications -~ Games
and more ~> Google Maps.

2. Scroll through the map.
3. Zoom in or out on the location you want.
To search for a specific location,

1. In Menu mode, select Applications - Games
and more —~ Google Maps.

2. Select Search and enter the address or the
category of the business.

36

To get directions to a specific destination,

1.

In Menu mode, select Applications -~ Games
and more — Google Maps.

. Select Menu — Directions.

Enter the addresses of the starting location and
the ending location.

Select Show directions to view on the map.



using advancea
functions

LLeam how to perform advanced operations and use
additional features of your mobile phone.

Use advanced call functions
LLearn about your phone’s additional calling
capabilities.

View and dial missed calls

Your phone will display calls you have missed on the
display.

When you have one missed call, select the call from
the event alert widget and select Voice call to dial.

When you have two missed calls or more, select the
call from the event alert widget and select Logs — a
missed call.

Call a recently dialled number

1. Inldle mode, press [e] to display a list of
recent numbers.
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2.

Select the number you want and select (&, | or
press [e] to dial.

Hold a call or retrieve a held call

Select Hold to place a call on hold or select
Retrieve to retrieve a held call.

Dial a second call

If your network supports this function, you can dial
another number during a call:

. Select Hold to place the first call on hold.

Enter the second number to dial and select New
call or press [F].

Select Swap to switch between the two calls.

4., To end the call on hold, select On hold — [E

38

To end the current call, press [ «s®].

Answer a second call

If your network supports this function, you can
answer a second incoming call:
1. Press [m] to answer the second call.

The first call is automatically placed on hold.

2. Select Swap to switch between the calls.

Make a multiparty call (conference call)

1. Call the first party you want to add to the
multiparty call.

2. While connected to the first party, call the
second party.
The first party is automatically placed on hold.

3. When connected to the second party, select
Join.



4. Repeat steps 2 and 3 to add more parties (if
necessary).

5. To end the multiparty call, press [«=»].

Call an international number

1. Inldle mode, select Keypad and select and hold
0 to insert the + character.

2. Enter the complete number you want to dial
(country code, area code, and phone number),
and then press [e] to dial.

Call a contact from the phonebook

You can call numbers directly from the phonebook
using stored contacts. » p. 31

1. In Menu mode, select Phonebook.
2. Select the contact you want.

3. Select (& next to the number you want to dial ~
<, (voice call) or [ (video call).

Use advanced phonebook functions

LLeamn to create namecards, set speed dial numbers,
and create groups of contacts.

Create a namecard

1. In Menu mode, select Phonebook — More —
My namecard.

2. Enter your personal details.
3. Select Save.

r,, You can send your namecard by attaching it to
J amessage or email or transferring it via the
Bluetooth wireless feature.

Set speed dial numbers
1. In Menu mode, select Phonebook.

2. Select the Contacts drop-down menu and
select Favourites.
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3. Select Add.
4. Select a contact.
The contact is saved to the speed dial number.

r,, The first five speed dial numbers will be
d assigned to the favourite contacts ([@]) on the
widget toolbar.

Create a group of contacts

By creating groups of contacts, you can assign
group names, ringtones, caller ID photos, and
vibration type to each group or send messages and
emails to an entire group. Start by creating a group:

1. In Menu mode, select Phonebook.

2. Select the Contacts drop-down menu and
select Groups.

3. Select Create group.

4. Set a group name, the caller ID photo, a group
ringtone, and vibration type.

5. Select Save.

6. Select Yes and add contacts to the group (if
necessary).

Use advanced messaging functions

LLearn to create templates and use templates to
create new messages.

Create a text template

1. In Menu mode, select Messages — Templates
— Text templates.

Select Create to open a new template window.
Select the screen.
Enter your text and select Done.

ISHEESRR I

Select More — Save as template.



Create a multimedia template

1. In Menu mode, select Messages — Templates
— Multimedia templates.
2. Select Create to open a new template window.

3. Create a multimedia message, with a subject
and desired attachments, to use as your
template. » p. 28

4, Select More — Save as template.

Insert text templates in new messages

1. To start a new message, in Menu mode, select
Messages — Create message > a message
type.

2. Select More — Insert > Text template ~> a
template.

Create a message from a multimedia
template

1. In Menu mode, select Messages — Templates
— Multimedia templates.

2. Select the template you want.

3. Select Stop — Send.
Your template opens as a new multimedia
message.

Create a folder to manage messages

1. In Menu mode, select Messages — My folders.

2. Select Create folder.
3. Enter a new folder name and select Done.

Move messages from the Inbox to your folders to
manage them as your preferences.
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Use advanced camera functions

Learn how to capture photos in various modes and
customise camera settings.

Capture a series of photos

1. Press and hold the Camera key to turmn on the
camera.

2. Rotate the phone anti-clockwise to landscape
view.

3. Select [ — Continuous.
4. Make any necessary adjustments.

5. Press and hold the Camera key to take a series
of photos.

42

Capture panoramic photos

1.

S

Press and hold the Camera key to tumn on the
camera.

Rotate the phone anti-clockwise to landscape
view.

Select [J — Panorama.
Make any necessary adjustments.
Press the Camera key to take the first photo.

Slowly move the phone to the right. The phone
captures the next photo automatically.

Repeat step 6 to complete the panoramic photo.



Capture photos in Smile shot mode
1. Press and hold the Camera key to turmn on the
camera.

2. Rotate the phone anti-clockwise to landscape
view.

3. Select [ — Smile shot.

4. Press the Camera key.

5. Aim the camera lens at your subject.
Your phone recognises people in an image and
detects their smiles. When the subject smiles,
the phone automatically takes a photo.

Capture divided photos

1. Press and hold the Camera key to tumn on the
camera.

2. Rotate the phone anti-clockwise to landscape
view.

Select [J — Mosaic.
Select an image layout.
Make any necessary adjustments.

Press the Camera key to take the divided
photos.

S

43

c
@,
=}
«Q
QD
2
)
=2
Q
(0]
Q
<
p=}
g
o
o}
[}




Capture photos with decorative frames Use camera options

1. Press and hold the Camera key to turn on the While using the camera, select €8 — (@) to access
camera. the following options:

2. Rotate the phone anti-clockwise to landscape Options Function
view. Focus mode Change the camera focus

. Select [J — Frame.

= 3 Timer Select the time delay

é' 4. Select a frame. Resolution Change the resolution option

8 5. Make any necessary adjustments. . Adjust the colour balance of the

g 6. Press the Camera key to take a photo with the it el image

% frame. Effects Apply a special effect

(Ci SO Adju$t the sensitivity of camera

S imaging sensor

- Exposuremeter  Select a type of exposure metre
Anti-Shake ?ﬁ%?/:fr(\aetr)wltur caused by vibration or

44




Options Function

Adjust the camera’s sensitivity to a

Options Function

Adjust contrast, saturation, and

WDR wide range of available light Adjust sharpness
Image quali Set the quality of your digital images . .

go ey : - E Customise camera settings
Adjust Adjust contrast, saturation, and

sharpness of photos

While using the camcorder, select §83 — to
access the following options:

Options Function

Timer Select the time delay

Resolution Change the resolution option

Adjust the colour balance of the

White balance video dlip

Effects Apply a special effect

WDR AQJuSt the camera’s sen‘smth\/ toa
wide range of available light

Video quality Adjust the quality of your video clips

While using the camera, select €8 — €83 to access
the following:

Setting Function

Guidelines Display the guidelines
Set the camera to switch to the
Review preview screen after capturing
photos or video clips
Suitar soumg) Select a sound to accompany the

shutter action

Audio recording  Tum the audio on or off

Select a memory location to store

Storage new images or video clips
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Use advanced music functions

Leamn to prepare music files, create playlists, and
store radio stations.

Copy music files via Samsung PC Studio

1. In Menu mode, select Settings — Phone
settings > PC connections > Samsung PC
studio —> Save.

2. Press [*=*] to return to Idle mode.

3. Using an optional PC data cable, connect the
multifunction jack on your phone to a PC.

4. Run Samsung PC Studio and copy files from the
PC to the phone.
Refer to the Samsung PC Studio help for more
information.

46

Copy music files to a memory card

1.
2.

Insert a memory card.

In Menu mode, select Settings — Phone
settings — PC connections —> Mass storage
— Save.

Press [#5» ] to retumn to Idle mode.

Using an optional PC data cable, connect the
multifunction jack on your phone to a PC.
When connected, a pop-up window will appear
on the PC.

Open a folder to view files.

Copy files from the PC to the memory card.



Synchronise your phone with Windows
Media Player

1.
2.

Insert a memory card.

In Menu mode, select Settings —~ Phone
settings > PC connections — Media player >
Save.

Press [#5»] to return to Idle mode.

4. Using an optional PC data cable, connect the

multifunction jack on your phone to a PC with
Windows Media Player installed.

When connected, a pop-up window will appear
on the PC.

Open Windows Media Player to synchronise
music files.

Edit or enter your phone’s name in the pop-up
window (if necessary).

7.

8.

Select and drag the music files you want to the
sync list.

Start synchronisation.

Create a playlist

1.

In Menu mode, select Music — Music player ~
Playlists.

Select Create.
Select the text input field.

Enter a title for your new playlist and select
Done.

To assign an image to the playlist, select Tap to
edit and select an image or capture a new
photo.

Select Save.
Select the new playlist.
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8. Select Add — Tracks. Store radio stations automatically

9. Select the files you want to include and select 1. In Menu mode, select App|icati0ns — FM
Add. radio.
Customise your music player settings 2. Select More > Self-tuning.
3. Select Yes to confirm (if necessary).

1. In Menu mode, select Music - Music player. ) ) )
pay The radio scans and saves available stations

2. Select Settings. automatically.
3. Adjust the settings to customise your music

player.

Option Function

g Set whether to play music in the
kv background when you end the
(Mg music player
Sound
effects

Backgroun
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Change the sound effects

Select music categories to display in

Music menu the music library screen

4, Select Save.
48




Find information of music

Learn to access an online music service and get
information about the songs you hear while on the
move.

1. In Menu mode, select Music — Find music.
2. Select Find music to connect to the server.

3. When your phone is successfully registered,
select (e to record a part of music you want to
find.

[,, Some service providers may not support this
d service and the database may not have
information for all songs.

and
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Use the Bluetooth wireless feature

1
u Sl n ‘tOO | S and LLearn about your phone's ability to connect to other
wireless devices for exchanging data and using
hands-free features.

appl |Cat|on8 Turn on the Bluetooth wireless feature

e e e VBT - 1. In Menu mode, select Applications —
S%s OW 10 WC V /Ol S
S rrewin yourt : Bluetooth.

and add

2. Select the circle in the centre to turn on the
Bluetooth wireless feature.

3. To allow other devices to locate your phone,
select Settings > On under My phone’s
visibility — Save.

If you selected Custom, set duration that your
phone is visible.

4. Select Save.




Find and pair with other Bluetooth-
enabled devices

1. In Menu mode, select Applications —
Bluetooth — Search.

2. Select and drag a device icon into the centre.

3. Enter a PIN for the Bluetooth wireless feature or
the other device's Bluetooth PIN, if it has one,
and select OK.

When the owner of the other device enters the
same PIN or accepts the connection, pairing is
complete.

r,, You may not need to enter a PIN depending on
d the device.

Send data using the Bluetooth wireless
feature

1. Select the file or item from one of your phone’s
applications that you want to send.

2. Select Send via or Send URL via — Bluetooth,
or select More — Send via Bluetooth.

Receive data using the Bluetooth
wireless feature

1. Enter the PIN for the Bluetooth wireless feature
and select OK (if necessary).

2. Select Yes to confirm that you are willing to
receive data from the device (if necessary).
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Use Remote SIM mode

In Remote SIM mode, you can make or answer calls
only with a connected Bluetooth hands-free car kit
via the SIM or USIM card on your phone.

To activate Remote SIM mode,

1. In Menu mode, select Applications —
Bluetooth — Settings.

2. Select On under Remote SIM mode.
3. Select Save.

To use Remote SIM mode, start the Bluetooth
connection from a Bluetooth hands-free car kit.
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Activate and send an SOS message

When you have an emergency, you can send an
SOS message asking for help.

',, This feature may not be available depending on
J your region or service provider.

1. In Menu mode, select Messages —~ SOS
messages —> Sending options.

2. Select On to tum on the SOS messaging
feature.

3. Select the recipient field to open the recipient list.
4. Select B to open your contact list.
5. Select the contacts you want and select Add.



6. Select a phone number (if necessary). Activate the mobile tracker
7. Select OK to save the recipients.

When someone inserts a new SIM or USIM card in

8. Select the Repeat drop-down menu and select your phone, the mobile tracker feature will
the number of times to repeat the SOS automatically send the contact number to two
message. recipients to help you locate and recover your
9. Select Save > Yes. phone. To activate the mobile tracker,
To send an SOS message, the touch screen and 1. In Menu mode, select Settings — Security s
the keys must be locked. Press the Volume key four Mobile tracker. @
times. 2. Enter your password and select Confirm. g
@ Once you send an SOS message, all phone 3. Select On to turn on the mobile tracker. 2
functions wil be suspended until you press the 4. Select the recipient field to open the recipient list §
Hold key. If you press [« ], phone functions ' ‘p‘ ‘ . P P N S
will be available, but the keys will remain 5. Select the recipient input field. 8
locked. 6. Enter a phone number and select Done. S
7. Select OK to save the recipients.
8. Select the sender input field.

53




o
@.
3
@
=
5]
o
2
)
2
a
S
=
=3
9]
=}
[

9. Enter the sender's name and select Done.
10. Select Save — Accept.

Make fake calls

You can simulate fake incoming calls when you want
to get out of meetings or unwanted conversations.
You can also make it appear as if you are talking on
the phone by playing back a recorded voice.

Record a voice
1. In Menu mode, select Settings — Application

settings — Call —~ Fake call > Fake call vioce.

. Select Voice recorder.
. Select (¢ to start recording.

2

3

4. Speak into the microphone.

5. When you are finished speaking, select (w).
6

. Select Set to set the recording as a response for
the fake call.

7. Select On under Fake call voice.
8. Select Save.

Make a fake call

To make a fake call, press and hold the Volume key
down in Idle mode.

To change the delay time before fake calls, in Menu
mode, select Settings — Application settings —
Call — Fake call — Fake call timer — an option —
Save.

Record and play voice memos

LLearn to operate your phone’s voice recorder.

Record a voice memo

1. In Menu mode, select Applications — Voice
recorder.

2. Select (e to start recording.



3. Speak your memo into the microphone. Edit images

4, When you are finished speaking, select (m).
Your memo is saved automatically.

Learn to edit images and apply fun effects.

Apply effects to images

Play a voice memo )
1. In Menu mode, select My files - Images > My

1. In Menu mode, select My files ~ Sounds — photos > a photo file.
Voice clips.
5 Select 5 2. Select @, &
. Select afile. S
. o 3. Select Edit — Effects — an effect option (filter, Lg»
3. Control the playback using the following icons: style, warp, or partial blur). S
i [
4, Select a variation of the effect to apply and select 3
() Pause playback Done. i)
°
> Play or resume playback To apply a blur effect to a specific area of an g
image, move or resize the rectangle and select §'
Blur — Done. @

) Scan backward in a file

Sean forward n ale 5. When you are finished with applying effects,

select Files — Save as.
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6. Select a memory location (if necessary). Transform an image

7. Enter a new file name for the image and select 1. Open animage to be edited. Refer to steps 1-2
Done. in “Apply effects to images”.

Adjust an image 2. Select Edit — Transform — Resize, Rotate, or

Flip.

1. Q;?en animage to pe ed\te”d. Refer to steps 1-2 3. Rotate or flip the image as desired and select
= in "Apply effects to images”. Done
@ 2. Select Edit > Adjust > an adjustment option To resize the image, select a size and select
Eo_f (brightness, contrast, or colour). Save — Done. Skip to step 6.
§ ;I'o aIdJUSt the image automatically, select Auto 4. Save the edited image with a new file name.
§ evel. Refer to steps 6-7 in “Apply effects to images”.
5| 3. Adjust the image as desired and select Done.
% 4. Save the edited image with a new file name. Crop an image
2 Refer to steps 5-7 in "Apply effects to images”. 1. Open an image to be edited. Refer to steps 1-2

in “Apply effects to images”.
2. Select Edit > Crop.

56




Move the rectangle over the area you want to
crop and select Crop — Done.

Save the edited image with a new file name.
Refer to steps 5-7 in “Apply effects to images”.

Insert a visual feature

1.

Open an image to be edited. Refer to steps 1-2
in “Apply effects to images”.

Select Edit —~ Insert — a visual feature (frame,
image, clip art, emoticon, or text).

Select a visual feature or enter text and select
Done.

Save the edited image with a new file name.
Refer to steps 5-7 in “Apply effects to images”.

Add a memo

1. Open an image to be edited. Refer to steps 1-2
in “Apply effects to images”.

2. Select Edit - Memo on screen.

3. Select a colour and enter a memo on the screen,
and then select Done.

4. Save the edited image with a new file name.
Refer to steps 6-7 in “Apply effects to images”.
Print images

Learn to print your image with an optional PC data
cable or the Bluetooth wireless feature.

To print an image using an optional PC data cable,

1. Connect the multifunction jack on your phone to
a compatible printer.

2. Open animage. » p. 32
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3. Select More — Print via -~ USB.
4. Set print options and print the image.

To print an image using the Bluetooth wireless
feature,

1. Open animage. » p. 32
2. Select More — Print via > Bluetooth.

3. Select a Bluetooth-enabled printer and pair with
the printer. » p. 51

4, Set print options and print the image.

Upload photos and videos to the
web

Learn to post your photos and videos to photo
sharing websites and blogs.

r,, Communities may not be available depending
d on your region or service provider.

58

Set your favourite destination list

1. In Menu mode, select Applications —
Communities.

2. Select Yes to set your favourite destination list
(if necessary).

3. Select Accept to confirm that you agree to the
general disclaimer.
',, The first time you access Communities, you
d will be prompted to confim.

4. Select the destinations you want to add and
select Save.
If you selected Update blog lists, new
destination sites are added to the list
automatically.

',, To edit the favourite destination list or update

d the lists, from the Communities screen, select
Settings — Preferred lists ~ Edit.



Upload a file

To upload photos and videos, you must have
accounts of photo sharing websites and blogs.
1. In Menu mode, select Applications >
Communities — Upload to web.

Select a destination you want to post to.
Enter the post details and attach a media file.
Select Upload.

Enter the user ID and password of the
destination (if necessary).

r/, You can also upload media files from Camera
d or My files, by selecting & or More —
Upload to web.

o K~ W

Use Java-powered games and
applications

Leamn to use games and applications powered by
award-winning Java technology.

',, Depending on the software of the phone, the
d download of java files may not be supported.

Download games or applications

1. In Menu mode, select Applications ~> Games
and more — More games.
Your phone connects to the website preset by
your service provider.

2. Search for a game or an application and
download it to the phone.
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Play games

1.

In Menu mode, select Applications - Games
and more.

2. Select a game from the list and follow the on-

screen instructions.

w Available games may vary, depending on your

service provider or region. Game controls and
options may vary.

Launch applications

1.
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In Menu mode, select Applications - Games
and more — an application.

Select More to access a list of various options
and settings for your application.

Synchronise data

LLeamn to synchronise contacts, calendar events,
tasks, and memos with the web server you have
specified.

Create a synchronisation profile

1. In Menu mode, select Applications —
Synchronise.

2. Select Add and specify profile parameters.
3. When you are finished, select Save.

Start synchronisation

1. In Menu mode, select Applications —
Synchronise.

2. Select a synchronisation profile.



3. Select the selected synchronisation profile or Read RSS feeds

Start sync. 1. In Menu mode, select Applications - RSS
4. Select Continue to start synchronisation with the reader.

web server you have speciied. 2. Select Update — a feed — Update — Yes.
Use RSS reader 3. Select a feed category — an updated feed.

w The auto update feature sets the phone to
>

Le;am t?‘ US‘? RSS rea(fjer o ‘?et thg \?test news and automatically update the RSS feeds at the &
information 1rom your favourite weosies. specified interval. You can activate the auto =
Create feed update feature by selecting RSS reader e
reate reeds More — Settings — Preferences. o
1. In Menu mode, select Applications - RSS ) . §
reader. Customise RSS reader settings 8
Q
2. Select Add. 1. In Menu mode, select Applications — RSS =
3. Select the URL input field. reader. 3
4. Enter the address of an RSS feed and select 2. Select More > Settings > Network settings.
Done. 3. Select [», next to a profile you want.
5. Select OK.
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4. Change the settings to customise your RSS
reader.

5. Select Save.

Create and view world clocks

Learn to view the time in another city and set world
clocks to appear on your display.

View a world clock

1. In Menu mode, select Organiser —~ World
clock.

2. Scroll through the world map and select a time
zone you want.
Create a world clock

1. In Menu mode, select Organiser — World
clock.
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Select (&) ~ Add.
Select a time zone.
To set daylight saving time, select w

Select Add to create your world clock.
The world clock is set as the second clock.

6. Select Add to add more world clocks (step 3).

SHEEEN I

Add a world clock to your display

In Dual Clock Display mode, you can view clocks
with two different time zones on your display.

After you have created a world clock,

1. In Menu mode, select Organiser —~ World
clock.

2. Select ] —~ Set as 2nd clock.
3. Select the world clock you want to add.
4. Select Set.



Set and use alarms

Learn to set and control alarms for important events.

Set a new alarm

1. In Menu mode, select Alarms.
2. Select Create alarm.

3. Set alarm details.

4. Select Save.

r,, The auto power-up feature sets the phone to
J automatically turn on and sound the alarm at
the designated time if the phone is turned off.

Stop an alarm
When the alarm sounds,

e Drag the slider to Stop to stop an alarm without
snooze.

e Drag the slider to Stop to stop an alarm with
snooze or drag the slider to Snooze to silence the
alarm for the snooze period.

Deactivate an alarm
1. In Menu mode, select Alarms.

2. Select Off next to the alarm you want to
deactivate.
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Use the calculator

Set a countdown timer

1.
2.

In Menu mode, select Organiser — Calculator.

Use the keys that correspond to the calculator
display to perform basic mathematical
operations.

Convert currencies or
measurements

1.

2. Enter the currencies or measurements and units

64

In Menu mode, select Organiser —~ Convertor
— a conversion type.

in the appropriate fields.

E SR

In Menu mode, select Applications — Timer.
Set the length of time to count down.
Select Start to begin the countdown.

When the timer expires, drag the slider to Stop
to stop the alerts.

Use the stopwatch

In Menu mode, select Applications —
Stopwatch.

Select Start to begin the stopwatch.
Select Lap to record lap times.
When you are finished, select Stop.
Select Reset to clear recorded times.



Create a new task

Manage your calendar

1. In Menu mode, select Organiser — Task.
2. Select Create task.

3. Enter the details of the task and select Save.

Create a text memo

1. In Menu mode, select Organiser -~ Memo.
2. Select Create memo.
3. Enter your memo text and select Done.

Leam to change the calendar view and create
events.

Change the calendar view

1.
2.

In Menu mode, select Organiser — Calendar.
Select More — View by day or View by week.

Create an event

1.

In Menu mode, select Organiser —> Calendar.

2. Select Create schedule.
3.
4. Select Save.

Enter the detalls of the event as required.
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View events
To view events of a specific date,

1. In Menu mode, select Organiser — Calendar.

2. Select a date on the calendar.
3. Select an event to view its detalils.
To view events from the event list,

1. In Menu mode, select Organiser — Calendar.

2. Select Schedule list.
3. Select an event to view its details.
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troubleshooting

If you are having trouble with your mobile phone, try these troubleshooting procedures before contacting a service

professional.

While using your phone, the following messages
may appear:

Message  Try this to solve the problem:

No sim Ensure that the SIM or USIM card is
mode installed correctly.

When the phone lock feature is
Phone lock  enabled, you must enter the password

you set for the phone.

Message  Try this to solve the problem:

When using the phone for the first time
or when the PIN requirement is
enabled, you must enter the PIN

PIN code supplied with the SIM or USIM card.
You can disable this feature by using
the PIN lock menu.

When you access a menu requiring

PIN2 code PIN2, you must enter the PIN2

supplied by the SIM or USIM card. For
detalls, contact your service provider




Message Try this to solve the problem: You enter a number, but the call is not dialled.

Your SIM or USIM card is blocked, e Ensure that you have pressed the Dial key: [e].
usually as a resut of entering your PN o Engure that you have accessed the right cellular
PUK code  incorrectly several times. You must network.

enter the PUK supplied by your

senvice provider. e Ensure that you have not set call barring for the

phone number.

Your phone displays “Service unavailable” or Another caller cannot reach you.
“Network error.”

e Ensure that your phone is tumed on.

e Ensure that you have accessed the right cellular
network.

e Ensure that you have not set call barring for the
phone number.

® \When you are in areas with weak signals or poor
reception, you may lose reception. Move to
another area and try again.

e You cannot access some options without a
subscription. Contact your service provider for
more detalls.
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Another caller cannot hear you speaking.
® Ensure that you are not covering the built-in
microphone.

e Ensure that the microphone is close to your
mouth.

e [f using a headset, ensure that it is properly
connected.
The phone beeps and the battery icon flashes.

Your battery is low. Recharge or replace the battery to
continue using the phone.

The audio quality of the call is poor.
e Ensure that you are not blocking the phone’s
internal antenna.

® \When you are in areas with weak signals or poor
reception, you may lose reception. Move to
another area and try again.

You select a contact to call, but the call is not
dialled.

e Ensure that the correct number is stored in the
contact list.
e Re-enter and save the number, if necessary.

The battery does not charge properly or
sometimes the phone turns itself off.

e The battery terminals may be dirty. Wipe both
gold-coloured contacts with a clean, soft cloth
and try charging the battery again.

o |f the battery will no longer charge completely,
dispose of the old battery properly and replace it
with a new battery.

Your phone is hot to the touch.

When you use several applications at once, your
phone requires more power and may heat up.
This is normal and should not affect your phone’s
lifespan or performance.
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alarms
creating, 63

deactivating, 63
stopping, 63

battery
charging, 18
installing, 16
low battery indicator, 19

Bluetooth
activating, 50

receiving data, 51
remote SIM mode, 52
sending data, 51

browser

d

see web or photo browser

calculator
see tools, calculator

calendar
see tools, calendar

calls
advanced functions, 37

answering additional calls, 38
answering, 27

basic functions, 27

dialing additional calls, 38
dialing missed calls, 37

from the phonebook, 39
international numbers, 39

making fake calls, 54
making, 27

multiparty, 38

placing on hold, 38
recently dialled, 37
retrieving held calls, 38
viewing missed, 37

clock
see world clock

communities
see tool, mobile blog

conference calls
see calls, multiparty



contacts
adding, 30

creating groups, 40
finding, 31

converter
see tools, convertor

countdown timer
see tools, countdown timer

FM radio
listening to, 33
storing stations, 48

Google Map 36
headset 28

images
adding memos, 57
adjusting, 56

applying effects, 55
cropping, 56

inserting visual features, 57
printing, 57

transforming, 56

internet
see web browser

Java
accessing applications, 60

downloading, 59
launching games, 60

key tones 25

lock
see phone lock

memo
see text or voice memos

memory card 19

messages
sending emall, 29
sending multimedia, 28
sending text, 28
viewing email, 30
viewing multimedia, 30
viewing text, 30

mobile tracker 53

multimedia
see messages

music finding 49
music player
creating playlists, 47
customising, 48
listening to music, 34
synchronising, 47
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namecards 39
offline profile 21
phone lock 26
photo browser 32
photos

advanced capturing, 42

basic capturing, 31
editing, 55
viewing, 32

radio
see FM radio

ringtone 26

RSS reader
see tools, RSS reader

silent profile 26
SIM card 16
SOS message 52

stopwatch
see tools, stopwatch

synchronisation
creating a profile, 60

starting, 60
task
see tools, task
templates
inserting, 41
multimedia, 41
text, 40
text

creating memos, 65
entering, 29
messages, 28

timer
see tools, countdown timer

tools
alarm, 63

calculator, 64
calendar, 65
convertor, 64
countdown timer, 64
image editor, 55
mobile blog, 58
RSS reader, 61
stopwatch, 64

task, 65



videos
capturing, 32

viewing, 33

voice memos
playing, 55
recording, 54

volume
call volume, 27

key tone volume, 25

wallpaper 26

web browser
adding bookmarks, 35

launching homepage, 35
widgets 24
Windows Media Player 47
world clock

creating, 62
setting dual display, 62
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Declaration of Conformity (R&TTE)

We, Samsung Electronics

declare under our sole responsibility that the product

GSM Mobile Phone : SGH-F480i

to which this declaration relates, is in conformity with the following
standards and/or other normative documents.

SAFETY  EN60950-1 : 2001+A11:2004

EMC EN 301 489-01 V1.6.1 (09-2005)
EN 301 489-07 V1.3.1 (11-2005)
EN 301 489-17 V1.2.1 (08-2002)
EN 301 489-24 V1.3.1 (11-2005)

SAR EN 50360 : 2001
EN 62209-1 : 2006

RADIO EN 301 511 V9.0.2 (03-2008)
EN 300 328 V1.7.1 (10-2006)
EN 301 908-1 V3.2.1 (05-2007)
EN 301 908-2 V3.2.1 (05-2007)

We hereby declare that [all essential radio test suites have been carried
out and that] the above named product is in conformity to all the
essential requirements of Directive 1999/5/EC.

The conformity assessment procedure referred to in Article 10 and
detailed in Annex(IV] of Directive 1999/5/EC has been followed with the
involvement of the following Notified Body(ies):

BABT, Balfour House, Churchfield Road,
Walton-on-Thames, Surrey, KT12 2TD, UK* c € 0 168
Identification mark: 0168

The technical documentation kept at :

Samsung Electronics QA Lab.

which will be made available upon request.
(Representative in the EU)

Samsung Electronics Euro QA Lab.

Blackbushe Business Park, Saxony Way, )0 C pa#z.

Yateley, Hampshire, GU46 6GG, UK*
2009. 05. 07 Yong-Sang Park / S. Manager

(place and date of issue) (name and signature of authorised person)

* Itis not the address of Samsung Service Centre. For the address or the
phone number of Samsung Service Centre, see the warranty card or contact
the retailer where you purchased your phone.



Some of the contents in this manual may differ from your phone depending on the software of the phone or your
service provider.

SAMSUNG ELECTRONICS ZUETI™

Printed in Korea
World Wide Web Code No.:GH68-23482A
http://www.samsungmobile.com English (EU). 05/2009. Rev. 1.0



	using this manual
	contents
	safety and usage information
	Safety warnings
	Safety precautions
	Important usage information

	introducing your mobile phone
	Unpack
	Phone layout
	Keys
	Display
	Icons

	assembling and preparing your mobile phone
	Install the SIM or USIM card and battery
	Charge the battery
	Insert a memory card (optional)

	using basic functions
	Turn your phone on and off
	Use the touch screen
	Access menus
	Switch applications
	Use widgets
	Access help information
	Customise your phone
	Use basic call functions
	Send and view messages
	Add and find contacts
	Use basic camera functions
	Listen to music
	Browse the web
	Use the Google Map service

	using advanced functions
	Use advanced call functions
	Use advanced phonebook functions
	Use advanced messaging functions
	Use advanced camera functions
	Use advanced music functions

	using tools and applications
	Use the Bluetooth wireless feature
	Activate and send an SOS message
	Activate the mobile tracker
	Make fake calls
	Record and play voice memos
	Edit images
	Print images
	Upload photos and videos to the web
	Use Java-powered games and applications
	Synchronise data
	Use RSS reader
	Create and view world clocks
	Set and use alarms
	Use the calculator
	Convert currencies or measurements
	Set a countdown timer
	Use the stopwatch
	Create a new task
	Create a text memo
	Manage your calendar

	troubleshooting
	index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice




